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RioScan ScanSeek 
Thank you for purchasing RioScan ScanSeek!  ScanSeek is a breakthrough application 
that will allow you to download any ODBC (Open Database Connectivity) data source to 
a Palm OS® handheld device. Through the handheld, data can be added, deleted, and 
edited, and then uploaded back into the original database on your PC. 
 
ScanSeek is optimized for use in barcode enabled data collection applications.  You can 
easily create portable data collection systems by linking ScanSeek to a Microsoft Excel 
spreadsheet, a Microsoft Access database, or a variety of other data sources.  You can 
even build a PDA front-end to your existing legacy system or server database in 
minutes.  ScanSeek has a considerable advantage over traditional data collection 
packages because it is Palm® OS based and ODBC compliant.  
 

What is RioScan ScanSeek? 
ScanSeek is an easy to use tool that allows you to rapidly build portable data collection 
applications based on nearly any data in your enterprise.  If you have data in any ODBC 
data source such as Microsoft® Excel, Microsoft® Access, ASCII text, Oracle®, Microsoft® 
SQL Server, or most other common formats, ScanSeek can assist you to build a data 
collection application based on that data.  Product features include: 
 

• One touch data synchronization 

• Support for a wide variety of databases through ODBC 

• Relational support, even between different databases 

• Record timestamps 

• Default field values 

• Read-only and required fields 

• Indexed searching on the handheld 

• Support for common data types 

• “Wizard” based application generation 

• No programming necessary 
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System Requirements  

• Handheld Requirements 
ScanSeek requires a Palm OS® handheld running Palm OS® version 3.0 or later. 
 

• Personal Computer Requirements 
ScanSeek requires a personal computer running the Microsoft® Windows® 
operating system (including Windows® 95, 98, ME, NT, 2000). 
 

• Other Requirements 
As with any application for the Palm OS®, ScanSeek requires that the HotSync® 
Manager application be installed and operating prior to installing ScanSeek. 
 

Before Installation 
Before installing ScanSeek, you must have successfully finished installing the Palm™ 
Desktop software included with your handheld.  Follow the directions included with that 
software to install it onto your personal computer (PC). 
 
After you have installed the desktop software, synchronize the handheld to your PC 
using the HotSync® Manager application (installed as part of the Palm™ Desktop 
installation procedure).  The first time the HotSync function is performed, you will be 
asked to assign a username to your handheld.   
 

Note: You must perform the HotSync function at least once prior to the 
installation of ScanSeek, otherwise the installation procedure may fail. 

 
Verify that HotSync® Manager 3.0 or later is currently running on your PC.  When 
HotSync is running, you will see a circular icon with red and blue arrows pointing in 
opposite directions on your taskbar located in the lower right hand corner of the screen.  
To determine which version of HotSync Manager is running, right-click on the icon and 
choose About… from the menu that appears. 
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Installation 
1. Start Windows®.  If you are using a networked computer, log in to an account with 

Administrator privileges. 
 

2. Close all open applications 
 

3. Insert the ScanSeek CD into the PC’s CD-ROM drive. 
 

4. If the installation program does not launch automatically, select Start>Run from the 
Windows® taskbar; otherwise, proceed to Step 6. 
 

5. When the “Run” dialog box appears, type: x:\setup, and then click OK. 
 
<<x represents the CD-ROM drive letter>> 
 

6. The InstallShield wizard appears. 
 

7. Click on the Next> button to continue 
 

8. Read the license agreement and, if you agree to the terms, click on the Yes button. 
 

9. The setup program will guide you through the ScanSeek installation procedure. 
 

10. During installation, you will be prompted to select the username corresponding to the 
handheld device on which you will want to install the handheld software. You will 
choose from a list of all user names that have previously synchronized to your PC. 

 

After Installation 
Verify that the software has been installed correctly. To do this, click your Windows Start 
Menu, select Programs and then look for the ScanSeek program group.  Up to date 
Troubleshooting information is available from the RioScan web site at 
http://www.rioscan.com. 
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Installing the Handheld Software 
To install the software on your handheld, simply HotSync your handheld to your PC.  
Place the handheld into its serial cradle and push the HotSync button on the cradle.  
This will automatically load the software onto the handheld.  Once installed, the 
ScanSeek application will be located under the category of “Unfiled” in the main 
application screen. 
  

Registration 
When you first use ScanSeek on the handheld you will be required to enter a license 
code in order to register the product (a separate license is required for each handheld). 
 
The license code for each handheld will be generated using the serial number displayed 
by ScanSeek the first time the application is run. 
 

NOTE:  The serial number displayed by ScanSeek is read from internal 
memory of the unit and is different from the serial number that appears on 
the back of the handheld. 

 
NOTE: If you are using a Handspring Visor with a barcode scanner Springboard 
module, you must have the scan module inserted into the unit at the time you 
retrieve a serial number for licensing.  In some cases, ScanSeek will retrieve a 
serial number from the scan module rather than from the Visor itself. 

 
To register your software, you will need both the Product Code and the serial number 
displayed on the handheld by ScanSeek.  The Product Code, which identifies the 
product you have purchased, is found in the software box that the product shipped in.  
Once you have both your handheld serial number and Product Code available visit 
http://www.rioscan.com/register.html to register your software. 
 
After completing the software registration process, you will be issued a license code.  To 
enter the license code in the ScanSeek application, tap the line labeled "License Code" 
and enter the code using your stylus.  If you have been issued a license barcode, you 
may scan the license barcode instead of entering the license code by hand.  Tap “OK” 
when you are done.   
 
 
RioScan Contact Information: 
 
Email: support@rioscan.com 
Web: http://www.rioscan.com 
 

http://www.rioscan.com/register.html


 

Getting Started 
 
Following successful installation of ScanSeek (see the Installation section of this 
manual), the installation program will return you to the Windows® desktop.   
 
This section will guide you through the steps involved to configure and register an ODBC 
data source for use with ScanSeek.  ODBC (Open Database Connectivity) is an open 
standard designed to support generic access to a wide variety of databases and 
database-like files.  Data Sources are system resources, designated by a Data Source 
Name, that applications (such as ScanSeek) can utilize to send and receive data.  To 
support access to your database or spreadsheet through ScanSeek, you must first set 
up an ODBC data source that identifies the filename and type of database you are using. 
 
To get you started, this manual will step through the creation of a sample data source, 
using Microsoft® Excel.   The use of Microsoft® Excel is intended for example purposes.  
The concepts presented should work equally well for any ODBC compliant data source.  
In a few places, we have added information related to Microsoft® Access for illustrative 
purposes. 
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Creating an Excel Spreadsheet as a Data Source 
An Excel spreadsheet can be used as a data source by creating a named range within 
the target spreadsheet. The named range can be used much like a database table 
through ODBC.  The following steps outline the creation of a simple spreadsheet with a 
named range.   
 
1. Launch Microsoft® Excel.  Begin with a new, empty worksheet. 
 
2. In cell A1, enter “Barcode.” In cell A2, enter “Description.” In cell A3 enter 

“Location.” 
 

 
 
 
3. To create the named range, use the mouse to select cells A1 through A3.  In the 

range box, type “example” followed by the Enter key. 
 

 
 

 
 
4. Select File>Save As.  Name the file and exit the application. 
 

Range Box 
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Installing ScanSeek Analyzer for Microsoft® Excel 
Included with ScanSeek is an Add-In for Microsoft® Excel named “ScanSeek Analyzer.”  
This tool verifies the contents of a named range within an Excel data file by searching for 
common errors. When configuring a Data Exchange to access a named range within an 
Excel spreadsheet, it is important that the spreadsheet is set up in a way that allows 
ScanSeek to treat it as a database table. The analyzer Add-In should always be used to 
verify spreadsheet data prior to configuration as a ScanSeek Data Exchange. 
 
To install the Add-In, follow these steps: 
 

1. Launch Microsoft® Excel. 
2. Select Tools>Add-Ins… from the menu bar. 
3. Select the Browse… button. 
4. Navigate to the ScanSeek program directory (e.g. C:\Program Files\ScanSeek) 
5. Select the ScanSeek file ScanSeekAnalyzer.xla and click on the OK button. 

 

Using ScanSeek Analyzer 
 
1. Create a named range in an Excel spreadsheet. 

 

 
 

2. Select Tools->ScanSeek Analyzer… from the menu bar. 
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3. In the “ScanSeek Analyzer” dialog box, select the named range to validate from the 
drop down menu. Click on the Analyze button to continue. 

 
 

 
 
 

4. If problems are discovered concerning elements in the named range, the ScanSeek 
Analyzer will display one or more confirmation dialog boxes. Click on the Yes buttons 
for each of the dialog boxes if you would like the analyzer to fix the problems 
encountered. 
 

 

 
 

 
 
 

Example confirmation dialog boxes. 
 
 

5. When the ScanSeek Analyzer has corrected all of the problems it encountered, a 
dialog box will be displayed summarizing the analyzer’s work. 
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Click on the Done button when finished. Then select File>Save As. Name the file 
and exit the application. 
 

 
 

Spreadsheet following modification by ScanSeek Analyzer. 
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Setting up Open Database Connectivity (ODBC) 
ScanSeek connects to a data source (Microsoft® Excel spreadsheet, Microsoft® Access 
database, etc.) through Open Database Connectivity (ODBC). Setting up an ODBC 
connection to a data source in the Windows® operating system is performed through the 
ODBC Data Source Administrator. 
 

Note: The procedure for configuring an ODBC data source varies 
between different versions of the Windows® operating system. Please 
follow the instructions applicable to the version of the operating system 
installed on your PC.  

 
The location of the ODBC Data Source Administrator varies between versions of the 
Windows® operating system. Follow the instructions, below, as applicable to the 
operating system installed on your computer system. 
 
For Windows® 95/98/NT the ODBC icon is located in: 

Start>Control Panel>Settings. 
 
For Windows 2000 the ODBC icon is located in: 

Start>Control Panel>Settings>Administrative Tools.  
 
Double click on the ODBC Data Source icon to display the “ODBC Data 
Source Administrator” dialog box.  For Windows® 9x, be sure to choose 
ODBC32. 
 

Note: See the section of this manual on using the ScanSeek Data 
Exchange Configuration Wizard for an alternate method of accessing the 
ODBC Data Source Administrator.  

 
1. When the ODBC Data Source Administrator dialog box appears, select the 
System DSN tab.         
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2. Click on the Add… button to display the “Create New Data Source” dialog 
box.          
       

   
          
  Select the data source’s file type and click Finish. 
 
 
To continue configuring a data source that references a Microsoft® Excel, 

spreadsheet, choose the Microsoft Excel Driver, click Finish, and proceed to 
Step 3. 
 
To continue configuring a data source that references a Microsoft® Access 

database, choose the Microsoft Access Driver, click Finish, and proceed to 
Step 7. 
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3. After clicking on the Finish button in Step 2, the “ODBC Microsoft Excel 
Setup” dialog box will appear.      
          

  
 

Enter the Data Source Name and Description into the appropriate 
fields.  The Data Source Name can be any meaningful name.  Click the 
Select Workbook… button. 

 
 
4.   After clicking on the Select Workbook button, the “Select Workbook” dialog 
box will appear.        
      

   
          
 Select the desired Excel file and click the OK button.  Uncheck the 
Read Only checkbox if you will be uploading changes from the handheld back 
to the spreadsheet. 
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5.  Click on the OK button in the “ODBC Microsoft Excel Setup” dialog box.
     

   
     
 
6.  Click the Options>> button. The “ODBC Microsoft Excel Setup” dialog box 
will expand to reveal the “Read Only” checkbox.  Be sure to uncheck the Read 
Only checkbox if you want to upload changes you make on the handheld.  If 
you unchecked the Read Only checkbox in Step 4, it should already be set 
correctly.   
     

    
 
 
 
 
Proceed to Step 10. 
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7.  After clicking on the Finish button in Step 2, the “ODBC Microsoft Access 
Setup” dialog box will appear.      
      

  
 

Enter the Data Source Name and Description into the appropriate 
fields.  The Data Source Name can be any meaningful name.  Click the 
Select… button in the Database area. 
 

 
8. After clicking on the Select… button, the “Select Database” dialog box will 

appear. 
 

   
       

Browse to and select the database file that contains your data, and then 
click on the OK button. 
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9.  Click on the OK button in the “ODBC Microsoft Access Setup” dialog box.  
          
          

  
 
 
10.  In the “ODBC Data Source Administrator” dialog box, you should now see 
the new System DSN listed in the “System Data Sources” table.  Click on the 
OK button to close the dialog box and return to the desktop. 





 

Configuring a ScanSeek Data Exchange 
ScanSeek accesses an ODBC data source using a ScanSeek Data Exchange. This 
section will explain how to setup and configure a Data Exchange. 
 

Planning Data Exchanges 
ScanSeek provides a great deal of flexibility in configuring your ODBC Data Source into 
a useful data collection application.  Each set of data that you work with in ScanSeek, 
along with it’s associated configuration information, is known as a Data Exchange.  
Before configuring a Data Exchange you should think through the following questions.  
Doing so will help you work with the ScanSeek Data Exchange Configuration Wizard to 
choose the correct options for your application. 
 
• Will every data record consist of a unique identifier or barcode along with some 

associated information?  Example: Each record describes a piece of equipment 
identified by a unique serial number.  There will never be two records with the same 
serial number. 

• Alternatively, will most records be duplicates of template records with minor changes 
between records?  Example: Each record describes a maintenance task performed 
on a piece of equipment.  In this case, the equipment serial number may appear in 
many records, although each record may have a different timestamp or work detail. 

• Are some fields in your records limited to a specific set of values?  Are these values 
enumerated in a database table or spreadsheet named range?  Example: A field in 
your record indicates the Model Number of a piece of equipment.  You would like all 
known Model Numbers to appear in a drop-down list on the handheld rather than 
have to re-enter them by hand for each record. 

• If you are downloading information from an existing data source, do you want to limit 
the download to a subset of the fields in a particular table or named range?  
Example:  Your database records include accounting information that will never be 
entered on the handheld.  You want to download all the fields except those related to 
accounting functions. 

• Are you modifying or copying data from records for which one or more fields should 
not be changed?  Example: You are scanning participants entering an exhibition hall.  
When you scan a badge, you want to verify participant information and record the 
date and time of the scan.  You don’t want to change any information except the 
date/time. 

• Are one or more fields in your application required?  Example: You are taking 
inventory and want to make sure that a current location is entered for every item 
scanned. 

• Will the application be used as part of a work process in which data changes rarely 
between scans?  Example: You are taking inventory and want to retain the last item 
number and location between scans until you manually change them. 

• Is your download data source the same as your upload data source?  Example: You 
are downloading an initial inventory list from one table in your database but are 
uploading all collected data into a separate “changes” table. 
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Configuring a Data Exchange  
In order to configure your ScanSeek application to work with your handheld device, you 
must set up one or more ScanSeek Data Exchanges. 
 
 
1. To begin setting up and configuring a ScanSeek Data Exchange, right-click on the 

HotSync® icon  and select Custom… from the menu, or choose 
Programs>ScanSeek>ScanSeek from the Windows Start Menu. 

  
2. In the “Custom” dialog box, highlight “ScanSeek” and click on the Change… button. 
 

   
 

 
3. The “ScanSeek Data Exchange” dialog box will appear next. All Data Exchanges 

configured for use on the handheld will be listed in the “Active/Data Exchange Name” 
box. To create a new Data Exchange click on the New… button.  To reconfigure an 
existing Data Exchange, click on the Configure… button. 
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4. In the “Add Data Exchange” dialog box, enter the name for the new Data Exchange, 
and click on the OK button.  You can choose any meaningful name for the Data 
Exchange. 

 

 
 
 
5. After naming the Data Exchange, the ScanSeek Data Exchange Wizard will appear. 

Follow the wizard’s on-screen instructions to complete the configuration of the new 
Data Exchange.  Click on the Next> button to get started. 
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6. The wizard will ask you to choose the ODBC data source where the target data will 
be stored.  A drop down menu will list the names of properly configured ODBC data 
sources (System DSNs).   If you have not yet configured a data source, choose the 
<new> option to bring up the ODBC Data Source Administrator.  See the section on 
Setting Up Open Database Connectivity (ODBC) for more information. 

 
Note: The data source may require a User ID and Password, if this is the 
case, you may enter that information into the appropriate fields in this 
dialog box. (Contact your System Administrator for assistance if you do 
not know the User ID and Password).  

 
When all information has been entered correctly, click on the Next> button. 

 

 
 
7. The wizard will prompt you to enter either the name of a range (if you are using a 

spreadsheet) or the name of a table (if you are using a database). Use the drop 
down menu to specify the range/table to be accessed. 
 
Next, specify the field to be used from the data source as a search field using the 
second drop down menu.   
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In choosing your search field, keep in mind that this is the field ScanSeek will use to 
scan, search, and identify individual records.  In many cases, the search field will 
correspond to the unique record identifier (or primary key) for your database table.  It 
will also be the first barcode scanned in most barcode scanning applications. 
 
Under the search field selection, ScanSeek has two options that allow you to 
customize the application’s behavior.   
 
This Data Exchange is read-only.  The first option allows you to specify that the Data 
Exchange contains read-only data.  If this option is checked, records cannot be 
added, modified, or deleted from the Data Exchange in the handheld application. 
 
This Data Exchange is a lookup table.  The second option allows you to specify that 
the Data Exchange can be used as a lookup, or cross-reference table for other Data 
Exchanges.  See the section on Data Exchanges as Lookup Tables for more 
information. 
 
On the lower right corner of the wizard you will also see a button labeled Advanced…  
Clicking this button takes you to the Advanced Properties screen where you can 
specify individual attributes for each of the fields in your range or table.  See the 
section on Advanced Field Settings for more information. 

 
 
8. After clicking on the Next> button, the wizard allows you to customize the way 

ScanSeek collects data and posts changes to your data source.  See the section 
titled “Planning Data Exchanges” for examples of various factors involved in 
choosing these options. 

 
Note: If you checked the “lookup table” option in the previous step, you will 
configure your lookup table options before proceeding to this screen. 
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Only allow one record per search field.  Choose this option if your search field 
uniquely identifies a record and no two records will share the same search field 
value.   
 
All changes result in new records.  Choose this option if your downloaded records 
are templates and you want all new records to be modified copies of existing 
records.  In this case, the search field will not be unique. 
 
Use a separate data source for upload.  Choose this option if you want to upload 
changes to a different table, range, or even different ODBC Data Source from your 
download.  See the section titled “Separate Output Option” for more information. 

 
9. If you have chosen to use a separate data source for uploading data, you will be led 

through two additional screens that allow you to select an ODBC Data Source and 
table/range for upload.  The ODBC Data Source and table chosen can be completely 
different from those chosen for download.  You will not be asked to identify a 
separate search field.  Once you are done configuring these options, click on the 
Next> button to continue. 

 
10. The wizard will display a summary screen that shows an overview of the Data 

Exchange configuration.  Verify all of the information to make sure that the Data 
Exchange is configured properly. Should you need to make corrections, click on the 
Back button.  If everything is correct, click on the Finish button. 

 
 

 
 

 
 
11. ScanSeek will attempt to validate your new Data Exchange configuration by verifying 

that all necessary attributes (e.g., ODBC Data Source, search field) have been 
assigned and all field options are valid.  If ScanSeek finds any errors, an error box 
will be displayed and the Data Exchange will be marked as Inactive. 
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When possible, an additional message window will be displayed describing any 
errors found in more detail. 
 

12. In the “ScanSeek Data Exchange” dialog box, verify that the checkbox to the left of 
the newly created Data Exchange is selected, marking the Data Exchange as Active. 

 
Note: Only Active Data Exchanges will be downloaded to the handheld.  You 
may want to de-activate a Data Exchange if you have more than one application 
you are using with ScanSeek but only want to use one at a time, or if you want to 
keep ScanSeek from synchronizing each time you HotSync. 

 

 
 
 
13.  To close the dialog box and exit the program, click on the   button in the upper 

right-hand corner of the “ScanSeek Data Exchange” dialog box. 
 
 



 30

Data Exchanges as Lookup Tables 
Lookup tables provide a method to associate the records from one Data Exchange as a 
list of options for a field in another Data Exchange.  In database terms, lookup tables 
create a relationship between two tables.  For example, you may use one Data 
Exchange to represent all possible inventory locations in your building.  A second Data 
Exchange may represent actual inventory records including an SKU, a location, and a 
count of items in that location.  Using the first Data Exchange as a lookup table for the 
location field in the second Data Exchange will allow you to limit those records to only 
hold valid locations.  In addition, ScanSeek will provide a drop-down list box on the 
handheld for choosing the valid locations from a list, eliminating data entry errors.  
 
The steps below will guide you through the setup of a Data Exchange as a lookup table. 
 
1. Begin by following steps 1 through 7 in the section entitled “Configuring a Data 

Exchange.” 
 

2. After configuring your download table and search field, click on the checkbox that 
reads “The data exchange is a lookup table”.  Click on the Next> button. 

 
     

 
 

3. The wizard will prompt you to choose a cross-reference field and a display field.  The 
cross-reference field, also referred to in ScanSeek as a Lookup ID, represents the 
actual value that will be placed in a Data Exchange field.  The display field, also 
referred to in ScanSeek as a Lookup Display, is often a more descriptive field that a 
user can recognize when viewing the data on the handheld.  Although the Lookup 
Display value will appear on the screen when viewing a data record, the Lookup ID 
value will be stored in the data field. 
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As an example, a typical database of parts will include a SKU or Part ID (such as 
#PPC-3345), along with a text description of the part (such as ¾ “ wingnut).  Your 
ordering system uses the SKU to identify all orders, but your field personnel using 
the handheld don’t have all of the SKU numbers memorized.  In this case, the SKU 
would be the Lookup ID, and the text description would be the Lookup Display. 

 
Note: Whenever possible, your Lookup ID should be the same as your Data 
Exchange search field.  Not doing so can cause considerable slow-down in the 
handheld application, particularly with large lookup tables. 

   
4. When you are done, click the Next> button and proceed to step 8 in the section titled 

“Configuring a Data Exchange”. 
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Separate Output Option 
There are many reasons to use a separate data source for upload.  In some cases, 
information policies of your organization may require that the original data sources must 
not be tainted by new data from external sources.  In other cases, the download data 
source contains a set of pristine “templates”, or records that are copied as the starting 
point for new data.  In such cases, you will often want to upload data to a separate 
spreadsheet, database, or file that only contains newly collected data. 
 

 
 
 
By configuring a separate output, ScanSeek will write all changes to a different (upload) 
data source. That upload data source and corresponding range/table must match the 
download range/table closely.  The target (upload) table must use field names that 
correspond exactly with the download table field names.  In addition, the data types 
(text, numeric, date/time, etc.) for each field must match. 
 
The actual implementation of the upload data source can be very different.  For instance, 
it is possible to download data from a relational database (such as Microsoft® Access) 
and upload data back to a spreadsheet (such as Microsoft® Excel).  Again, the only 
requirement is that the upload and download data sources must have matching field 
names and field types. 
 

Advanced Field Settings 
 
In addition to supporting customization of a Data Exchange as a whole, each field in an 
included table or range can be customized separately.  The steps below will guide you 
through each of the settings and their use. 
 

1. Begin by following steps 1 through 7 in the section titled “Configuring a Data 
Exchange”. 

 
2. From the screen shown below, click on the Advanced… button. 
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3. The wizard will display a screen that shows a list of all fields in the download 

table, a number of checkboxes representing attributes that can be set for each 
field, and a pull-down selection indicating the lookup table (if any) associated with 
a field.  By default, ScanSeek marks every field as Included in the Data 
Exchange, and leaves all other attributes empty.  To modify the attributes of a 
particular field, begin by clicking on the field in the list box. 

 

 
 
 
4. To indicate that a particular field should not be included in the Data Exchange, 

and therefore will not appear on the handheld, uncheck the “Include this field in 
the Data Exchange” checkbox.  The search field for the Data Exchange must be 
included.  Attempting to uncheck the Included box for the search field will result 
in the following error message. 
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5. To indicate that a field is required, check the “Required” checkbox.  Notice that 
the “Read-only” checkbox is unavailable for required fields.  When editing a 
record on the handheld, required fields must be filled in before saving. 

 

 
 
 

6. To indicate that a field is read-only, check the “Read-only” checkbox.  Notice that 
the “Required” checkbox is unavailable for read-only fields.  When editing a 
record on the handheld, you will not be able to modify read-only fields regardless 
of the read-only status of the Data Exchange.  This option is particularly useful 
when using the “All changes result in new records” option for the Data Exchange.  
In this case, you may include necessary information in each record without 
allowing the handheld user to change the “template” part of the record. 

 

 
 
 

7. When performing repetitive data collection tasks, there is often only a small 
amount of information that changes between records.  For instance, while 
performing inventory you may be collecting data for hundreds of items that share 
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the same location and count.  To keep from having to re-enter the same data for 
each record, you can choose the “Default to last value” option.  When this option 
is selected, the designated field will retain its value from record to record.  The 
carried over value will remain the same until manually changed by the handheld 
user.  Once changed, the new value will again be carried over between records, 
and so on. 

 

 
 
 
8. By default, the current date and time will be used for every date/time field 

whenever a user adds a new record on the handheld.  This is not the behavior, 
however, when copying an existing record.  By default, the value of the original 
record is copied along with the rest of the data when copying.  In cases where 
the copied record represents a template record, and an included date/time field 
represents a timestamp for the newly created record, check the “Default to 
current time” option for the timestamp field. 

 
Note: The “Default to current time” option will only change the behavior of 
ScanSeek when copying existing records.  New (blank) records always 
default date/time fields to the current date time regardless of this option. 
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9. To designate a lookup table associate with a field, choose the Data Exchange 

that contains the appropriate lookup values from the drop-down list box at the 
bottom of the form. 

 
Note: Only existing Data Exchanges that have been designated as lookup 
tables are available in the lookup table list box.  It is good practice to 
configure lookup table Data Exchanges before configuring the Data 
Exchanges that use them. 

 

 
 

 
The Lookup ID field associated with the selected lookup table Data Exchange 
must have the same type (text, number, date/time, etc.) as the field you are 
configuring.  If the field types do not match, you will see the following error. 
 

 
 

 
See the section titled “Data Exchanges as Lookup Tables” for more information 
on creating lookup table Data Exchanges. 
 

10. In addition to allowing you to include and exclude individual fields, ScanSeek 
also supports re-ordering the fields as they appear on the handheld.  Fields will 
appear on the handheld in the same order that they appear in the field list on the 
form.  To move a field up in the list, highlight the field and click the + button next 
to the field list.  To move a field down in the list, highlight the field and click the – 
button next to the field list.  The picture below shows the field list after the 
AssetID field has been moved up. 
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11. When you have finished configuring each field in your Data Exchange, click on 
the Done button. 





 

Working with ScanSeek on the Handheld 
 
Start the application on the device by tapping the ScanSeek icon once.  
 

 

 
 
ScanSeek will display the “Choose a Data Exchange” screen.  This screen serves as an 
access point for all Data Exchanges configured within ScanSeek.  Once a Data 
Exchange has been configured and made Active, it will appear in this screen the next 
time you launch the application after performing the HotSync® function.   
 
To begin working with a Data Exchange, tap its name. 
 

 
 
The “Seek in <data exchange name>” screen presents a summary view of the data in 
the Data Exchange.  The left hand column lists the search field value for every record.  
The right hand column shows the first field in the Data Exchange other than the search 
field.  On the upper right corner of the screen you will see an icon that looks like a 
checklist.  Tapping on this icon will return you to the “Choose a Data Exchange” screen. 
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Searching for a Record 
ScanSeek provides a fast way to search for records in your Data Exchange.  To find a 
record, begin writing the first few letters or numbers of the search field into the Scan: 
text field at the bottom of the screen.  As you write, ScanSeek will quickly move to the 
closest match. 
 

 
 

Once you see the record you are looking for on the screen, simply tap on the record to 
view it in more detail.  Alternatively, you may write in the entire search field value and tap 
the OK button. 
 

 
 

Adding a New Record 
To add a new record, write in the search field or scan a barcode from the “Seek in” 
screen.  If writing, tap the OK button.  ScanSeek will prompt you to confirm the creation 
of a new record. Tap the Yes button to continue.  
 

 
 
ScanSeek will then construct a new record and display the “Edit” screen.  You will notice 
that the Edit screen looks similar to the detail view of the record.  You can differentiate 
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between the two by observing that the Edit screen uses a bold font to display field 
information and provides extra spacing between fields. 
 

 
 

Copying a Record 
If your Data Exchange was configured with the “All changes result in new records” 
option, the detail view screen will include a button labeled “Copy”.  To copy the record 
and begin editing, simply tap on the Copy button. 
 

 
 

Editing a Record 
To edit a record, you must Add a new record, Copy an existing record, or choose the 
Edit button from the record detail view.  The Edit screen displays the name of each field 
in the Data Exchange followed by the field data.  Longer field names may be truncated.  
To edit a particular field, tap on the field data.  The manner in which you edit a field 
depends upon the field’s type, which is automatically determined by ScanSeek during 
HotSync.  ScanSeek supports five different field types: Text, Integer, Floating Point, 
Boolean, and Date/Time. 
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Editing a Text Field 
To edit a text field, tap anywhere on the text associated with the field.  Longer text 
values may span more than one line.  The text editing popup will appear.  This popup 
includes the field name in the upper left, an editable text field, a scroll bar (may not be 
visible for short text fields), and a “Close” button marked with an x.  Text on the popup 
may be edited through Graffiti, the virtual keyboard, or by scanning a barcode. 
 

 
 

Editing an Integer Field 
To edit an integer (whole number) field, tap anywhere on the line containing the number 
you want to change.  The virtual keyboard will appear with the numeric keypad 
displayed.  Use the numeric keypad to make any changes.  Tap the Done button to 
finish. 
 

 
 

Editing a Floating Point Field 
To edit a floating point (number with decimal point) field, tap anywhere on the line 
containing the number you want to change.  The virtual keyboard will appear with the 
numeric keypad displayed.  Use the numeric keypad to make any changes.  Tap the 
Done button to finish. 
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Editing a Boolean Field 
To edit a Boolean (True/False) field, tap on the True or False value displayed.  A pop-up 
list box will appear containing the two values True and False.  Tap on the list entry you 
want to change the field to. 
 

 
  

Editing a Date/Time Field 
Date values and time values associated with a single date/time field are edited 
separately.  To change the date portion of a field, tap on the date line of the field you 
want to change.  The Calendar control will appear, allowing you to quickly choose any 
date.  Start by selecting the year and month of the date, then tap on the desired day of 
the month to finish.  Alternatively, tap on the Today button to use the current date. 
 

 
 

To change the time portion of a field, tap on the time line of the field you want to change.  
The Time control will appear, allowing you to quickly choose any time.  Tap the OK 
button to finish. 
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Note: The Time control shown in this picture will appear on devices running Palm 
OS version 3.1 or higher.  Version 3.0 devices will display a different Time control 
that allows selection of both a start and end time.  ScanSeek will only use the start 
time selected with that control. 

 

Editing a Lookup Field 
Fields that have lookup table Data Exchanges assigned to them appear as drop-down 
list boxes on the handheld.  In the example below, an Edit screen is shown in which the 
ItemName field uses another Data Exchange as a lookup table.  You may choose any of 
the lookup records listed, or add a new record to the lookup Data Exchange by tapping 
the <New> entry.   
 

 
 
After tapping <New>, ScanSeek will change the Edit screen to show the lookup Data 
Exchange.  In this case, the record only has one field, whose initial value is set to 
<change this>.  To enter a new ItemName, tap on the <change this> entry and change 
the text in the popup text box.  When finished, tap the x button in the text box and then 
the Done button in the Edit screen. 
 

 
 
ScanSeek will then return you to the original record you were editing.  Notice that the 
ItemName field has been set to the new value you entered. 
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Delete a Record 
To delete a record, begin by selecting the record from the “Seek in” screen, or 
alternatively by editing the record in the Edit screen.  Next, tap on the silkscreen Menu 
icon located on the lower left corner of your screen next to the Graffiti writing area.  
Choose the Delete Record option from the Program menu.  You will be prompted to 
verify deletion of the record.  Tap Yes to delete the record.  Once you have deleted the 
record, you will be returned to the “Seek in” screen. 
 

  
 

Note: To cancel the creation of a New record while in Edit mode, simply use the 
Delete Record menu option. 

 

Handheld Program Preferences 
The ScanSeek handheld application allows you to customize the way your data 
collection application works through a set of program Preferences.  To change your 
program Preferences, tap on the silkscreen Menu icon located on the lower left corner of 
your screen next to the Graffiti writing area.  Choose the Preferences option from the 
Program menu.  The “ScanSeek Preferences” dialog will appear. 
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The following four options are available. 
 

1. Don’t ask when adding new.  Choose this option to avoid having to verify the 
addition of each new record by tapping Yes on the following screen. 

 

 
 

2. Add new instead of copying.  If your Data Exchange has been configured to use 
the “All changes result in new records” option, each time you write or scan an 
existing search field value you will be taken to a detail view in which you may 
copy the existing record by tapping on the Copy button. 

 

 
 

Choose the Add new instead of copying option if you would prefer to create new 
blank records and proceed directly to the Edit view. 
 

3. Hide ‘lookup’ Data Exchanges.  Choose this option to hide all lookup table Data 
Exchanges in the “Choose a Data Exchange” screen.  This option is often useful 
in applications that use a single data collection Data Exchange and multiple read-
only lookup table Data Exchanges. 

 
4. Auto-Scroll when scanning.  For barcode-enable handheld devices, ScanSeek 

has been optimized to support multiple scan workflow.  When this option is 
chosen, ScanSeek will automatically set the current editing focus to the first 
empty text field in the application, indicated by a solid underline beneath the field 
value.  After each scan, ScanSeek will move the focus to the next empty field 
following the scanned field.  If no more empty fields exist, and the user has not 
manually edited any fields, ScanSeek will indicate completion of record editing 
with three short beeps.  Pressing the scan button a final time will indicate 
acceptance of the record, and ScanSeek will proceed as if the Done button had 
been pressed.  See the section titled “Working With a Barcode Scanner” for more 
information. 
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When you are finished customizing ScanSeek Preferences, tap the OK button.   
 
Note: Preferences are shared by all Data Exchanges in the application.  Changes 
made to Preferences while working with one Data Exchange will continue to be used 
for all other Data Exchanges until they are again changed by the user. 

 

Changing Data Exchanges 
To finish working with a Data Exchange and begin working with a different one, choose 
the Choose Data Exchange menu option from the “Seek in” form.  Tap on the silkscreen 
Menu icon located on the lower left corner of your screen next to the Graffiti writing area.  
Choose the Choose Data Exchange option from the Program menu.  ScanSeek will 
return to the “Choose a Data Exchange” form, where you may choose a new Data 
Exchange to work with.  Alternatively, you can tap on the Data Exchange List icon in the 
upper right corner of the “Seek in” form.   
 

 
 
 

Deleting a Data Exchange 
There may be times in which you want to completely delete a Data Exchange.  This may 
occur if you want to discard changes made on the handheld to keep them from being 
uploaded during HotSync, if you are finished working with a Data Exchange 
permanently, or if you have made changes to your Data Exchange configuration on the 
PC and need to remove a Data Exchange to allow HotSync to complete properly. 
 
To delete a Data Exchange, select the Data Exchange from the “Choose a Data 
Exchange” screen.  Then select the Delete Data Exchange menu option from the “Seek 
in” form.  Tap on the silkscreen Menu icon located on the lower left corner of your screen 
next to the Graffiti writing area.  Choose the Delete Data Exchange option from the 
Program menu.  You will be asked to confirm the deletion.  Tap Yes to permanently 
delete the Data Exchange. 
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To delete all Data Exchanges from the handheld, select the Delete All menu option from 
the “Choose a Data Exchange” screen.  Tap on the silkscreen Menu icon located on the 
lower left corner of your screen next to the Graffiti writing area.  Choose the Delete All 
option from the Program menu.  You will be asked to confirm the deletion.  Tap Yes to 
permanently delete all Data Exchanges. 
 

  
 
Note: Deleting a Data Exchange from the handheld will not have any effect on your 
PC Data Exchange configuration or on any data in your PC data source.  It will not 
cause PC data records to be deleted. 
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Working With a Barcode Scanner 
ScanSeek supports barcode scanner enabled Palm OS devices including the Symbol 
SPT series and the Handspring Visor utilizing a Symbol CSM150 or PSC Momentum 
scan module. 

 
Note: If you are using a Visor, you must have the scan module inserted into the unit 
at the time you retrieve a serial number for licensing.  In some cases, ScanSeek will 
retrieve a serial number from the scan module rather than from the Visor itself. 

 
Barcode scanning features are automatically enabled whenever ScanSeek detects 
barcode scanner capabilities.  Scan features are enabled on the “Seek in” form and the 
Edit form of the application. 
 
From the “Seek in” form, scan a barcode associated with the search field to 
automatically view a matching record.  You do not need to tap the OK button.  If the 
scanned barcode value does not match an existing search field, ScanSeek will assume 
you are adding a new record. 
 

 
 

From the Edit form, the current scan focus field will have a solid (vs. gray or dotted) 
underline.  Scanning a barcode will automatically update the scan focus field to the 
scanned value.  If you have chosen the Auto-Scroll feature from the application 
Preferences, the focus will then move to the next empty text field in the application. 
 

 

 
 
If you have not tapped the screen with your stylus while editing the record, ScanSeek 
will beep three times after scanning the last scannable field, indicating completion.  
Pressing the scan button on the handheld one more time will send a Done message to 
the handheld, with the same effect as tapping the Done button.  The purpose of this 
feature is to support scanning applications that do not require looking at or tapping on 
the handheld screen during data collection.  In this mode, a user can scan a search field 
to add a new record, quickly scan collected data, and then press the scanner button a 
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final time to save the record.  Tapping on the screen any time a record in Edit mode will 
cancel this functionality until a new record is edited. 
 
To scan a barcode into a field that does not have the scan focus, simply tap on the field 
to bring up the popup text form.  Once the form is displayed, scan the barcode.  
ScanSeek will automatically save the barcode data and close the popup text form. 
 

 
 
Note: ScanSeek has been designed so that every scan function can also be 
completed using the stylus on a non scan-enabled device. 

 
 



 

Synchronizing Data Through HotSync 
 
Whether you are downloading a Data Exchange to your handheld for the first time, or 
uploading hundreds of new records, all data transfer between the handheld and your PC 
data source occurs through the HotSync process.  To initiate a HotSync, place your 
Palm OS device in its cradle and press the HotSync button located on the cradle.  The 
following steps occur during each HotSync. 
 

1. ScanSeek attempts to open your Data Exchange configurations on the PC and 
ensure that each has a valid configuration. 

 
2. Each handheld Data Exchange that contains new or modified records is 

compared to the PC Data Exchange.  If the number, names, order, and type of 
the fields match, synchronization will continue.  If not, ScanSeek will write an 
error message to the HotSync log and will not continue synchronizing. 

 
3. Data from each Data Exchange is transferred to the upload data source.  

ScanSeek chooses the order of upload (e.g., which Data Exchange is uploaded 
first, second, etc.) based upon dependencies between lookup fields and lookup 
table Data Exchanges. 

 
4. If errors are encountered while writing data to the data source, ScanSeek will 

place a log file in the main application directory, usually C:\Program 
Files\ScanSeek.  The log file will have the same name as the Data Exchange 
followed by the suffix “.log”.  Each line in the log file will correspond to the data 
source record being written to, in comma-delimited format.  In addition, specific 
details of the error encountered are written to the application log.  See your 
operating system documentation for more details on where to find the application 
log. 

 
5. Once data upload has been completed, ScanSeek clears all data off the 

handheld and begins downloading data for each Active Data Exchange.  
Although upload occurs for all Data Exchanges on the handheld, only Active 
Data Exchanges will be downloaded. 

 
6. If errors are encountered during download to the handheld, they will be written to 

the HotSync log and ScanSeek will not continue synchronizing. 
 

7. Once HotSync is complete, ScanSeek is ready for use on the handheld.  If any 
errors occur during synchronization, the HotSync Manager application will 
indicate that errors have been written to the error log. 

 
 

 
 





 

Advisory/Warnings  
This section contains important information about various configuration and usage 
issues that can cause problems when working with ScanSeek. 

Changing Data Structures 
Once a ScanSeek Data Exchange has been configure and synchronized to the 
handheld, the system assumes that the original data structure for that Data Exchange 
will not change. If the number, type, or order of any data field changes, ScanSeek will 
have difficulty determining how to post changes made on the handheld.  As a result, 
ScanSeek will refuse to synchronize a Data Exchange when it determines that either the 
original ODBC Data Source or the Advanced Field Settings are no longer consistent with 
the data structure on the handheld. 
 
The proper way to change a data structure is as follows: 

1. Mark the Data Exchange you want to modify as Inactive by unchecking the 
Active checkbox in the Data Exchange list on the PC. 

2. Synchronize all handheld devices to upload any data residing on the handheld 
back to the PC.   

3. On the handheld, the Data Exchange should now be removed.  If not, delete the 
Data Exchange by choosing the Delete Data Exchange option from the “Seek in” 
screen of that Data Exchange. 

4.  Make any desired changes to the original data source and, if necessary, update 
the previously defined ODBC System DSN to reflect those changes. 

5. In the ScanSeek conduit configuration wizard, either delete and recreate the 
Data Exchange for that data source or reconfigure the existing Data Exchange to 
produce the desired changes. 

6. Mark the Data Exchange as Active and HotSync again. 
 

Cross Lookup Loops 
When configuring Data Exchanges as lookup tables it is important to understand that 
Data Exchanges must not reference each other in a loop. That is, if Data Exchange A 
has been configured to use Data Exchange B as a lookup table, you cannot 
subsequently configure Data Exchange B to reference Data Exchange A as a lookup 
table. This configuration causes problems when uploading data back to the PC and 
should be avoided. 
 

Sync Regularly 
Please keep in mind that the only way to synchronize data between the PC and the 
handheld is by performing a HotSync® function. We recommend that users synchronize 
data often, especially when collecting new data on the handheld, as this will provide a 
backup of collected data. Should a handheld be damaged or lose power, data that has 
not already been synced to the PC will be lost. 
 

Re-installing the Handheld Software 
If it becomes necessary to re-install the handheld software application, we advise the 
user to first delete the application from the handheld and then install it again from the PC 
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using the Palm® Installation Tool.  Not deleting the application before reinstalling may 
result in unstable program behavior on the handheld. 

 



 

Troubleshooting and Support 
 
Up to date troubleshooting and Frequently Asked Questions information is available on-
line at http://www.rioscan.com.  Please visit the site regularly for information on patches, 
upgrades, and other important information.  Contact your RioScan software reseller for 
information about obtaining an annual telephone support contract.  We are always 
available to answer questions via email.  Send your technical questions, feature 
requests, and other comments to support@rioscan.com. 
 
 

http://www.rioscan.com/
mailto:support@rioscan.com




 

Glossary Of Terms 
 
conduit– Software that extends the functionality of the HotSync® Manager application. 
Conduits are used to exchange data between the Palm OS® handheld and desktop 
computer.  ScanSeek uses a conduit to transfer data between the handheld and PC. 
 
Data Exchange–The virtual connection configured within the ScanSeek Data Exchange 
Wizard that refers to a specific ODBC DSN and establishes relationships associated with 
fields contained in the DSN and the ScanSeek application.   A Data Exchange is the 
combination of data and configuration information. 
 
data source–The source of information (data records), usually in the form of a database 
file or spreadsheet, referenced by an ODBC DSN. 
 
Data Source Name (DSN)–The name given to a configured ODBC data source. 
 
field–A single piece of data within a record.  In a spreadsheet, each cell will be a 
separate field. 
 
HotSync® Manager–A utility application provided by Palm, Inc. that enables data 
transfer between applications on the handheld device and a PC. 
 
license code–A unique number generated by RioScan using a handheld serial number 
and ScanSeek product code. 
  
Open Database Connectivity (ODBC)–A standardized database access method 
developed by Microsoft Corporation. The method provides a way for applications to 
access data from other applications through the insertion of a middle layer known as a 
an ODBC driver. 
 
ODBC System DSN–An ODBC data source that has been configured for access by all 
users on a PC. 
 
ODBC User DSN–An ODBC data source that has been configured for access by a 
specific user on a PC. 
 
PC–Personal Computer. 
 
handheld serial number–A unique serial number generated ScanSeek on a handheld 
device.  The serial number is obtained from either system read-only-memory or from an 
electronic code embedded in a Springboard scan module.  
 
system tray–An area of the task bar reserved for the presentation of application 
shortcuts and status icons. Introduced with Microsoft® Windows 95. 
 
unique identifier–A data field in a database table that contains a unique value. This 
value allows you to sort data. It may also be referred to as a unique key, a sort key, or 
an index. 
 

 


	R
	RioScan ScanSeek
	What is RioScan ScanSeek?
	System Requirements
	Before Installation
	Installation
	After Installation
	Installing the Handheld Software
	Registration

	G
	Getting Started
	Creating an Excel Spreadsheet as a Data Source
	Installing ScanSeek Analyzer for Microsoft® Excel
	Using ScanSeek Analyzer
	Setting up Open Database Connectivity (ODBC)
	
	
	
	
	For Windows® 95/98/NT the ODBC icon is located in:
	Start>Control Panel>Settings.
	For Windows 2000 the ODBC icon is located in:
	Start>Control Panel>Settings>Administrative Tools.

	(Proceed to Step 10.





	C
	Configuring a ScanSeek Data Exchange
	Planning Data Exchanges
	Configuring a Data Exchange
	Data Exchanges as Lookup Tables
	Separate Output Option
	Advanced Field Settings

	W
	Working with ScanSeek on the Handheld
	Searching for a Record
	Adding a New Record
	Copying a Record
	Editing a Record
	Editing a Text Field
	Editing an Integer Field
	Editing a Floating Point Field
	Editing a Boolean Field
	Editing a Date/Time Field
	Editing a Lookup Field

	Delete a Record
	Handheld Program Preferences
	Changing Data Exchanges
	Deleting a Data Exchange
	Working With a Barcode Scanner

	S
	Synchronizing Data Through HotSync
	A
	Advisory/Warnings
	Changing Data Structures
	Cross Lookup Loops
	Sync Regularly
	Re-installing the Handheld Software

	Troubleshooting and Support
	G
	Glossary Of Terms

